Third Person Controller - Melee Combat

Thank you for supporting this asset, we developed this template because a lot of developers have
good ideas for a Third Person Game, but building a Controller is really hard and takes too much
time.

The goal of this template is to deliver a top quality controller that can help those who want to
make a Third Person Game but are stuck trying to make a controller.

With this template, you can set up a 3D Model in just a few seconds, without the need of knowing
advanced scripting or wasting time dragging and dropping game objects to the inspector, instead
you can just focus on making your game.

--- Invector Team ---
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| FIRST RUN
“IMPORTANT*
This is a Complete Project, and as every complete project it includes a custom InputManager, Tags, Layers,
etc... Make sure that you import on a Clean Project.

Importing Complete Project

Importing @ complete project will overwrite your current project settings. If you're not sure what this means, you should switch to an empty project before importing
this package

Cancel Import

Importing on an existent project

There are basically 3 files that are extremely necessary for the correct functioning of this
template.

e InputManager.asset - We have a custom input mapped to support the Xbox360 controller,
without it you will receive errors about missing input.

e TagManager.asset - Includes all the necessary Tags and Layers for the project to work
correctly.

e DynamicsManager.asset - this will update the Collision Matrix of our Layers, for example we
need the layer "Triggers” to not collide with the layer "Player”.

After importing the template you can manually import those files by going to the tab Invector >
Import ProjectSettings.

Invector  Window Help

I Basic Locomotion >
Melee Combat >
Shooter >
Inventory >
Resources >
Help >
Al Controller >
Import ProjectSettings




Import Unity Package n

Now that you have imported the necessary files, you can explore the several demo scenes and
figure out what kind of Third Person Game you want to create.



| CREATING A CHARACTER CONTROLLER

Make sure that your fbx character is set up as Humanoid

|| © Inspector u,ma\rig,aﬁm ﬁug}tﬁng ﬁhm'[cr.& &=

1 V-bhot@Highpoly Import Settings

2,

| open |

[ woiel T

Animation Type | Humanaid
Ayatar Definition Nane
Legacy
Optimize Game Object N Generic
'+ Humanoid

I

Canfigure... |

evert || Apply |

To setup a new basic character, go to the tab Invector > Basic Locomotion > Create Basic Controller

To setup a new basic character, go to the tab Invector > Melee Combat > Create Melee Controller

To setup a new basic character, go to the tab Invector > Shooter > Create Shooter Controller

Invector  Export  Mobile Input

I Basic Locomotion
Melee Combat
Shooter

Inventory

Welcome Window
Addons

F5M Al
Ltils

Help
Import ProjectSettings

Cinemachine  Window Help

>

Create Basic Controller

Components -]
Actions >
Resources >




Make sure your Character is Fully Rigged and set up the FBX as a Humanoid, then assign the FBX to the field “FBX

Model then Click on the button “Create” to finish the character.

V CHARACTER CREATOR WINDDW

IWvBasicController_Template
WVBOTZ.0_Custom




The vBasicController_Template, vMeleeCombat_Template and vShooter_Template depending on what
controller you’re creating, is already assigned in the Template field and is a Controller Prefab that contains
everything ready to go, you just need to assign the model to update the Animator Avatar.

Tag | Player t| Layer [ Player =
Prefab | Qpen I Select | | overrides v |
¥ .~ Transform i - 8
Position X[-7.59411 ¥ 1.36458|Z -6.1455:
Rotation X0 ¥ |-542.76Z 0 ]
Scale ®[1 1 [1 1z[1 ]
¥ 55 & Animator @ = =
Controller |l Invector@BasicLocomotion |
Avatar [None (Avatar) | a
Apply Root Motion  [of
Update Mode [ Animate Physics al
Culling Mode | cull Update Transfarms
Clip Count: 79
Curves Pos: 0 Quat: 0 Euler: 0 Scale: 0 Muscles: 10270
Generic: 0 PPtr: O
Curves Count: 10270 Constant: 2277 (22,2%) Dense:

6652 (64.8%) Stream: 1341 (13.1%)

| ¥ = ¥V Third Person Controller (Script) o B
‘ THIRD PERSON CONTROLLER
|
‘ ¥ « WV Third Person Input (Script) - 8
|~ INPUT MANAGER
|
¥ Rigidbody @ = #
|| Mass [50 |
Drag [0 ]
Angular Drag [0.05 ]
N | ooy M

The Character Creator window takes care of all the hard work for you.

Depending on what Controller you created (Basic, Melee or Shooter) you will find different components inside,
such as the Inventory or AimCanvas (Shooter requirement)

TQInwectnr_ShnnterMelee* a1 =
T wShooterMeleeController
> | 3D Model
'[\‘I_,J InvectorComponents
P@Bndyﬁnaps

> Eui ThrowManager

AT
Pﬁﬁimﬂanvas >
[;L-JvThirdPersunCamera -
[ [4) GameController_Example

Hit Play and enjoy ©



| HOW IT WORKS?

The Controller works with six main scripts:

1- vHealthController takes care of Health/Stamina and has the method TakeDamage to apply damage.

2-

vCharacter - it prepares the vHealthController to be a vCharacter using our animator parameters, ragdoll

and action system.

vThirdPersonMotor handles all the information of rigidbody, colliders, verifications of ground distance,
stepoffset, slope limit, etc...

vThirdPersonAnimator is responsible to control the behavior of animations

vThirdPersonController manages methods like sprint, crouch, roll, jump, etc...

vThirdPersoninput receives all the input and calls every method of the other scripts on Updates.

~
Get Animator -

Base Ragdoll -

Advanced TakeDamage -
ChecklflsCrouched -
HandleTriggerColliderEvents - )

AnimatorLayerControl -
ActionsControl -
TriggerRandomldle -
UpdateAnimatorParameters -
DeadAnimation -
SetlnputMagnitude -
TurnOnSpot Methods -
MatchTarget -
SetActionState -

IsAnimatorTag -
-y

L

{ ™
~ InputHandle -
* Generic Methods * Movelnput -
Sprintlnput -
SetlLockBasiclnput - Crouchlnput -
SetLockAlllnput - Strafelnput -
ShowCursor - +— Jumplnput -
LockCursor - Rollinput -
SetLockCameralnput - Cameralnput -
IgnoreCameraRotation - UpdateCameraStates -
SetWalkByDefault - ChangeCameraStates
SetStrafeLocomotion - ResetCameraStates -
UpdateHUD - y

vHealthController

vCharacter

ThirdPersonMotor

ThirdPersonAnimator

ThirdPersonController

ThirdPersoninput

! Update - )
‘ FixedUpdate - |
1 LateUpdate -
! OnAnimatorMove -

................

- Base Health
- Base TakeDamage

-

.

- MoveCharacter
- StopCharacter

- RotateCharacter
- SetMoveSpeed
- SnapToGround
- StepOffset

- AirControl

- CheckGround

- CheckHealth

- CheckStamina

- CheckRagdoll

- StopMove

- ControlCapsuleHeight
- CrouchMethods
- JumpMethods

- RollIMethods

- SlideMethods

“

- ControlAnimatorRootMotion
- ControlLocomotionType
- ControlRotationType

- ControlKeepDirection

- UpdateMoveDirection

- Sprint

- Crouch

- Strafe

- Jump

- Roll

- OnTriggerStay

- OnTriggerExit




| HOW TO APPLY DAMAGE TO THE PLAYER

We have a few examples on how to apply damage to the Controller, basically you need the vObjectDamage script
which is attached to the Pendulum and Spikes, an Object Damage can send damage to any object that uses a
vHealthController.

v OBJECT DAMAGE

Close Properties

- vObjectDamage

Damage Cptions

narmed

A wFPSController (Transform)

CnTriggerEnter

0.5
- DamageType: Used together with the HitParticleDamage component, you can trigger different particles for
different types of damage.

For example if you have an area with fire, you can add a vObjectDamage there and add a DamageType of
"FireDamage”, then add a Custom Damage Effect with the same DamageType to your HitDamageParticle on your
Character and add the particle effect to burn your character.

¥ || ¥ v Hit Damage Particle (Script) #,

v/ HITDAMAGE PARTICLE

(1)

bloodSplash

FireDamage

*This component is attached to the Controller or any object that contains the HealthController



- DamageValue: How much damage it will be applied to the vHealthController of the target.

- Stamina Block Cost: You can ignore that option, it's only for the ThirdPersonController.

- Stamina Recovery Delay: You can ignore that option, it's only for the ThirdPersonController.

- Ignore Defense: If you're using a MeleeCombat Controller, it will ignore the defense and apply damage anyways.
- Active Ragdoll: It will activate the ragdoll on your character, if it has one.

- Reaction ID: You can trigger specific hit reaction animation, you can use -1 if you don't want to trigger any
animation.

- Override Damage Sender: Assign the root object otherwise the Al will target the object that has this
component instead. For Example: If you apply the vObjectDamage to be a Hitbox of a LeftHand of a character,
the vHealthController or Al will have the LeftHand as the target instead of the GameObject parent.

- Tags: What tags you will apply damage to

- Method: OnTriggerEnter or OnCollisionEnter

- Continuous Damage: Useful for fire damage for example

- Damage Frequency: Frequency to apply the damage, if Continuous Damage is enabled.

Using the Ragdoll Colliders as BodyParts to inflict precise damage.

SHOOTER > If you want to cause damage for each body member using the ragdoll colliders, UNCHECK the
“Disable Colliders” and you can add damage multiplier on each member.

.
i
]
=
s
H
g
2
v
i

o & [Hies [ static »

Tag [ Untagged #| Layer [ BedyPart

#| )

¥ .~ Transform
Position %[-3.8921% ¥ [1.060997 2[-0.0193<
Rotation %[-0.001 Y -0.001 |Z[0.046
Scale x[T vt Jz[r

¥ .. Rigidbody &,
Mass

Drag
Angular Drag

sitien (% [JY [z
Freeze Rotation [ % []¥ (]2
¥ i ¥ Box Collider FES

Edit Collider
(]

Is Trigger
Material None (Physic Material) °
Center %[0,00026( ¥ [0.076944| 2 0,00557'

Size x[0.37782" ¥ [0.25995] z|0.24112"
¥[c| MV collision Message (Script) 2,

(7) You can add damage multplierfor cxample causing
tnice damage on Headshots

OPEN EVENTS

Add Component

* You must use a different Layer in the Ragdoll Colliders like “BodyPart” and another for the main capsule collider
like "Enemy”, this way the Detection will detect the Enemy object as a target, but the ShooterManager will
actually apply damage to the "BodyPart".



v DAMAGE RECEIVER
(1)

- vwDamageReceiver
||

CLOSE EVENTS

On Receive Damage (vDamaage)

List is Empty

Bodyparts use the Damage Receiver to receive damage.

A DamageReceiver is attached to each ragdoll collider, this will allow to Player or Al to apply damage to each
bodypart instead of the CapsuleCollider.

- Damage Multiplier: multiply the damage value
- Override a Reaction ID: Check this option to override the hit reaction animation to trigger a specific animation.

For example, if you want to cause 2x damage and trigger a specific reaction animation when shooting in the
Head, simply change the values in this component.



| CREATING A NEW CAMERA STATE

With the Third Person Camera you can create new CameraStates to manage different values, states
like “Default”, “Aiming”, “Crouch”, to set up new camera position, distance, height, etc.

CAMERA STATES
(1]

MewCameraState (vThirdPersanCa

NEW CAMERASTATE DELETE STATE

Default

Free Directional

Default

You can call the method ChangeCameraState() from the tplnput via Triggers or Custom Scripts.
Example:
tplnput.ChangeCameraState(string cameraState, bool useLerp = true)

The first string value is the State Name that you created on the Camera Inspector, the second value
is a bool, leave it true if you want a smooth transition to this state or false if not.

You can also call a method to reset to the defaultCameraState

tplnput.ResetCameraState();



You can create a new CameraState List Data and assign it in the CameraState List field on TP
Camera Inspector.

Invector  Export Window Help

Basic Locomotion ¥ Create Basic Controller

UEEB L T ’ Components » # Scene

e ’ Resources ¥ Mew CameraState List Data
Actions > Mew Audicsurface

Inventory »

FSh Al
Help ¥

Mew Ragdell Generic Temnplate

Import Project5ettings
Utils

CameraMode - Free Directional

This CameraMode offers a free directional - orbital around the character, with a lot of options to customize and
make over the shoulders, or above the character, zoom (mouse only) etc...

CAMERA STATES
o

NEW CAMERASTATE DELETE STATE

Default




CameraMode - Fixed Angle

This is a feature to use for Isometric or Topdown games, you can set up a fixed rotation for the camera and make
games like Diablo or MGS 1.

CAMERA STATES
(1)

NewCameraState (vThirdPersonCa

NEW CAMERASTATE DELETE STATE

Default

1.5

CameraMode - Fixed Point

Fixed Points are states that you can create to use the Camera as a CCTV mode (Oldschool Resident Evil series),
this state will follow the character by default or you can check Static Camera to make it fixed.

CAMERA STATES
(1)

MewCameraState (vThirdPersonCa

NEW CAMERASTATE DELETE STATE

Default
10
60 |

01/01

NEW POINT

REMOVE CURRENT POINT




You can also create multiple points and change with the TriggerChangeCameraState that has an option for
smooth transition between points or not. *always leave a safe-space between triggers




| XBOX CONTROLLER SUPPORT

This package works great with the 360 controller and XboxOne controller.
Make sure you imported our InputManager by going to Invector > Import ProjectSettings.

For other controllers like PS4, Logitech or Generic you need to remap the InputManager based on your controller
inputs.

| INPUT MANAGER

The InputManager manages input for the character actions and movement.

If you created a Basic Locomotion it will use the vThirdPersoninput, if it’s a Melee Combat character it will use
the vMeleeCombatinput, and the Shooter uses the vShooterMeleelnput.

SHODTER/MELEE INPUT

+ wShooterMeleelnput

Inputs Camera Settings

Haorizantal Input
Werticall Input

Jump Input
(Space ] Auis -1
(¢ ]Axis]-1]
CE) 1 Y

You can remap the input and disable it if you don’t need to use it for your game.



| HEAD TRACK

*Shooter - automatically add the headtrack in order to aim up/down

Invector  Mobile lnput  Window  Help

! Basic Locomaotion b Create Basic Controller

I Melee Combat » Components » Ragdall

i Besources 5 HitDamageParticle
Help 3 HeadTrack

Culling Fade
FootStep

HEAD TRACK

Close Properties

-~ yHeadTrack

Settings Bones Detection

UpDownAxis: Depending on your character’s rig, the orientation could be different so if you're looking up/down and the
character is responding left/right instead, try changing the value 1 of the X, Y, Z until the character looks normal.
Weights: You can set different weights depending on the Locomotion Type (Free Movement or Strafe)

Angle X and Y: You can limit the max angle to look up/down and left/right



Smooth: the speed to look at something

AnimatorTags: Which animator tags will ignore the Headtrack, for example you have an animation that the character
opens a door and look at the knoble, it’s best to not use the headtrack while this animation is playing, making the
animation play as it was designed without the headtrack interfering.

Offset Spine//Head: more offset options in case you want to fine tune your headtrack.

Follow Camera: tracks the camera forward, disable when using a topdown view

Always FollowCamera: force the controller to always follow the camera regardless of AnimatorTags

To make the character look at an object, you need to add the component vLookTarget into the object, you can
take a look at several examples in the DemoScenes.




| FOOSTEP AUDIO SYSTEM

Video tutorial: https://www.youtube.com/watch?v=gxesgNHOUBM

When you create a new Character the FootStep component will be already attached, if you want to
add a component into another Character go to the 3rdPersonController Menu > Component >
FootStep. The component will automatically create a sphere collider on the foot of your character,
but you need to make sure that the Radius and Position of the sphere is touching the ground.

You can select the LeftFoot and RightFoot Sphere and manipulate the Center XYZ to position as
you like, and change the Collider Radius too, the size of this sphere will depend on your Rig bone
size. Assign the “defaultSurface” that comes with the package to have an example of how it
works.

To create a new AudioSurface go to the 3™ Person Controller menu > Resources > New
AudioSurface.

3rd Person Controller  Mobile Input  Asset Store Tools  Window  Help
i Create Mew Character
Create MNew Melee Weapon

Help ¥

Component 3
ﬁemuu:a » Mew CameraState List Data
Mew Character Template



https://www.youtube.com/watch?v=gxesgNH0UBM

Now you can create Custom Surfaces, to play other audio clips based on the material that the
sphere collider will hit. Assign the new CustomSurface to a new CustomSurface on the FootStep

Inspector.
lnspector Flighting  Services  <Mavigation & .=
metalSurface Qe
- | Cpen |

TEXTUREDRMATERIALNAMES

FOOTSTer SYaTeM aY INVECTOR
L]
01
WLeftFoot (Sphere (I W RightFoot (Sphere
AUDIOCLIFS
OerAULT FOOTSTEP AUDID
_defaultSurface (Audio:

Drag your audio chps here!

CUSTOMSURFACES

(P TIONAL PARAME [ cR

¢ Metal (FootMizer)

You can assign an AudioMixer for better control surfaces, and you can instantiate a Particle as well, see the
example on the DefaultSurface call ‘smoke’ that also uses a StepMark sprite call SimpleStepMark.



V1.1 Using the FootStep system in objects with multiple Materials

If your gameobject has multiple materials and you need to play a specific material, you can use the
FootStepHandler script and set the correct Material Index of your object. (*See example on the Ladder prefab)

¥ . MIMesh Renderer FEY
Cast Shadows | On 3

Receive Shadows &

" r
Wladder_chromao e
|G ladder_Metal | @

R :'lﬂlnnd,_P[n\hzs_ = |
rm&mmwﬁmmnne {Tlrannf.ormj ] ﬁ
w0 = Reflection Probe | @ Weight 1.01

v[¢/  Foot Step Handler (Script) @ =

Script - FootStepHandler |a
Material Index |1 [
Step Handle Type | Material Hame_ A




| CREATING A RAGDOLL

Creating a Ragdoll is just easy as creating your Character, just go to the tab Invector > Basic
Locomotion > Components > Ragdoll.

If you have your character selected on the Hierarchy, all the fields will autofill, if not, just click on
your character and it will autofill for you, this template was designed to save time, so you don’t
have to waste your time dragging and drop every bone, instead just hit the “Create” button and
it’s ready to go.

Male sure your character is in T-Stand,
Malce sure the blue axis faces in the same direction the chracter is looking.
Use flipFarward to flip the direction

Script |- RagdollBuilder

--- Animator of target Character ---
Animataor f:: 3rdPersonController (Animator)

--- Bones ---

Root | A Hips (Transform)

Left Hips iALef‘tUpLeg (Transform)
Left Knee | A LeftLeg (Transform)

Left Foot | A LeftFoot (Transform)
Right Hips | ARightUplLeg (Transform}
Right Knee E_LRig_htLe_g (Transform)
Right Foot | A RightFoot (Transform)
Left Arm | A LeftArm (Transform)
Left Elbow | A LeftForeArm (Transform)
Right Arm | L RightArm (Transform)
Right Elbow | A RightForeArm (Transform)
Middle Spine | A Spinel (Transform}
Head | A Head (Transform)

28 B OEcR® 8 \BaRg 0 o

--- Properties ---
Enable Projection =)

Proportional Mass 4

Total Mass will be ignored and set to 1 if Proportional Mass is true
Total Mass |20

Strength o
Flip Forward ]

We strongly recommend keeping the Enable Projection and the Proportional Mass enabled, and do
not forget to use Scale Factor 1 on your fbx Model. This you provide better behavior of your
ragdoll.



To enable the ragdoll, you can use the Script ObjectDamage or just call this line on the
OnCollisionEnter method.

hit.transform.root.SendMessage ("ActivateRagdoll”, SendMessageOptions.DontRequireReceiver);




v1.1b - Add “Ignored Tags” you can add a list of tags for objects that are children of the Player to
keep the rotation correctly, otherwise it will mess up the rotation when the Ragdoll are on.

v RAGDOLL SYSTEM

(1)
- wRagdaoll

= collisionAudio (Audio Source)
RagdollCollision

z____

Ignore Ragdoll

* SHOOTER > If you want to cause damage for each body member using the ragdoll colliders,
UNCHECK the “Disable Colliders” and you can add damage multiplier on each member.

Ps* Don’t forget to add the Layer “BodyPart” for each collider.

| HOW TO ADD NEW ANIMATIONS/ACTIONS?

We have 2 excellent video tutorial showing examples on how to add simple and complex animations

Simple > https://www.youtube.com/watch?v=VVgkSIQ4x2M
Complex > https://www.youtube.com/watch?v=hILWnslQz-c

| RAYCAST CHECKERS


https://www.youtube.com/watch?v=VVqkSlQ4x2M
https://www.youtube.com/watch?v=hlLWnsIQz-c

Head Detection is a SphereCast that will detect if an object above, and keep the character crouched, use the
same layer as the Ground Layer (Default). Just adjust to sync with the height of your capsule collider.

StopMove is a Raycast that detect any object with the layer (Default, StopMove) to prevent the character to walk
in place, you can use a StopMove in an invisible wall for example, and the camera will not clip, because the
culling layer is set to “Default”.

SlopeLimit will prevent the character from walking in absurd angle heights, float customizable on the Player
Inspector.

StepOffset is to help the character walk in custom height steps, adjust the values on the Player Inspector.

Check for SlopeLimit




| TOPDOWN / 2.5D / POINT & CLICK CONTROLLER / MOBILE

We have different types of controllers that are included in the project as a bonus, you can import those packages
by going to Invector > Add-ons

Welcome To Invector

INVECTOR

N GETTING STARTED ADD-ONS
I 06ILE EXAMPLES IMPORT PACKAGE

Simple mobile example, basic, melee and shooter
scenes included

TOPDOWN EXAMPLES IMPORT PACKAGE

Topdown controller basic, melee and shooter
scenes included

_ CLICKTOMOVE EXAMPLES IMPORT PACKAGE

Similar to Diablo gameplay, basic and melee
scenes included

@Cisplay this window at startup

If you don’t own the Melee or Shooter templates, you don’t need to import their folders.

TgIrwectur-SrdPersnnContrnIler
¥ &3 Add-ons
» 55 Builder
» £ Camera_vMansion
» 63 Controller_2.5D Platform
» 53 Controller_Maobile
» 63 Controller_Point&Click
¥ 53 Controller_TopDown
> G Basic
» 63 Melee (Required Melee Template)
» 63 Shooter (Require Shooter Template)
README_TOPDOWN
» &3 FreeClimb
53 Stealthkill
» G5 Swimming
» 53l Zipline




To turn your Third Person Controller into a TopDown or Isometric controller just go into your ThirdPersonCamera
and change the CameraState to TopDown@CameraState, Isometric@CameraState or 2.5@CameraState

depending on what controller you want.

CAMERA STATES

This sattings will always load in this List, you can ereate

@ more List's with different settings for another characters ar

_ Isometric@CameraState (v3rc

Go to the add-on folder you want and replace your current vThirdPersonController component for the
vTopDownController or 2_5Dcontroller in the Player Inspector.

To use the Point&Click you can still use the vThirdPersonController, but you will need to replace the Input to
vPointAndClickinput or vMeleePointClickinput (if it’s a melee character), for more information check the

Invector_Point&Click_Melee.

And for the 2.5DController check the 2.5Demo scene, you will need a 2.5Path to navigate.



| MOBILE CONTROLS

You can import the Mobile demo scenes by going to the menu Invector > Addons.

After importing the mobile package, you can create a regular ThirdPersonController using the Character Creator
Window and drag and drop a Mobile Ul prefab inside your character.

You can find the MobileUl prefab examples inside each folder Basic, Melee or Shooter

ps* You must own the MeleeCombat or Shooter Templates in order to use their prefabs, otherwise you will
receive warnings about missing content.

OPENBAG




Make sure to check the options “Unlock Cursor and Show Cursor” when using the Mobile Ul.

vThirdPersoninput > Basic Controller
vMeleeCombatinput > Melee Controller
vShooterMeleelnput > Shooter or Shooter w/ Melee Controller

MELEE INPUT MANAGER

-~ wMeleeCombatInput

Camera Settings Events

After setting up the controller and aligning the handlers, search for the Mobile Ul Controls prefabs:

MobileUl_ShooterMelee_Inventory - if you want to use Inventory
MobileUl_ShooterMelee_Nolnventory - if you don’t want to use Inventory, check the demo scenes to see how it
works and choose one style for your game.

You can use the component vCheckltemlIsEquipped if you’re using the Inventoryto turn on/off mobile buttons:

\/ CHECK IF [TEM IS EQUIPPED

-« wCheckltemIsEquipped
Maone (V Item Manager)

s
EnableMelee

1
Melee Weapon ]

On Is Item Equipped ()

Runtime Cnly GameObject.SetActive

Uhelee 0| ¥
-~ ==

on Is Item Unequipped ()

Runtime Only % || SameObject.SetActive

(wMelee | off |




If you’re not using the Inventory, you can use the vCollectShooterMeleeControl Events to manage the buttons, it
identifies if you’re using a shooter weapon or a melee weapon only.

V/ COLLECT SHOOTER MELEE CONTROL

« wCollectShooterMeleeControl

L

Default Melee Events

On Equip Shooter Weapon ()

Runtime Cnly # || GameObject.SetActive
WwsShoot | ©f [«

| Runtime ©nly # || GameObject. SetActive 3]

|WReload | o]




CAMERA CULLING FADE

We add a Culling Fade script for the camera to avoid see through the character’s mesh, you can set up the
distance to start fading and an offset.

Example:

Our Culling Fade will set up automatically for the default Standard Shader of Unity’s, but you also can use custom
shaders, just make an additional copy with the fade material and assign in the “Optional Fade Material” field.

v Eculling Fade Control (Script) oy
Script |- CullingFadeControl | e
Target Object A 3rdPersonController (Transfor| @

Distance To Start Fa 1.5 |
Distance To End Fad 1 |

Offset ®i0 J¥joses  |Zio |
Renderer |_,_._<_‘l.l'__B_qt | (]
[ Criginal Material [ Optional Fade Material
(@base-1 | ©||@None (Material) | ©
|__H_base-2 | @ iUNune (Material) | @
| chrome | @ | W None (Material) | @
‘@ rubber | ©| WNone (Material) | @
Ometal | © ||@None (Material) | ©

If you are using the Standard Shader, just select the Rendering Mode “Fade” on the Material.



base-1 *,

v Shader | Standard v
Rendering Mode [ Fade : |
Main Maps

 oAlbedo 12
o Metallic 0 o

Smoothness

ial“durmal Map |U-:-5

o Height Map

P

" ©0cclusion
 @Emission -éﬂ (¢ 5
@ Detail Mask -
Tiling X1 ¥ |1
Offset A0 |¥le

The character will look like this (picture below) but you can fix by
Zwrite of Standard Material”.

right clicking at the material and “Change

Lerramn

@ Height Map
EventSystem — :
@ Occlusion
 @Emission .
. ©Detail Mask
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UPDATE V1.1B - now the script will be attached into the Controller just like the Ragdoll and the Footstep,

It’s a modular feature.



| GENERIC ACTION (HOW TO INTERACT WITH OBJECTS)

Video tutorial is also available: https://youtu.be/hlLlWnslQz-c

The GenericAction is a system designed to trigger simple interaction animations such as opening a door, jump

over an obstacle, push a lever, etc...

GENERIC ACTION

(1]

-« viGenericAction
Action

OPEN EVENTS

(This component is already added to a Player when creating a new controller)

You need to add a vTriggerGenericAction component on a collider IsTrigger to perform the action.
In the Input tab you can assign an Actionlnput to trigger the action and select between the InputType
GetButtonDown, GetDoubleButton, GetButtonTimer or perform an AutoAction as soon as the player enters the

trigger.

TRIGGER GENERIC ACTION

Events

USE Action Input



https://youtu.be/hlLWnsIQz-c

There are several options in the Trigger tab such as disabling the player gravity and collision, only performing the
action if the player is facing the trigger forward, destroying the trigger after the interaction, etc... every option
has a description of what it does:

TRIGGER GENERIC ACTION

SwTriggerGenericAction

Inpt Animation

Events

In the Animation tab, you must assign the name of the animation clip you want to play it
(not required, you can perform an action without playing an animation as well)

If you need to align the player into a specific position you can use the MatchTarget option or our Curve system to
place the character into a custom transform while playing the animation.


https://docs.unity3d.com/ScriptReference/Animator.MatchTarget.html

TRIGGER GENERIC ACTION

SwTriggerGenericAction
Inpt Animation

Events

Steplp

target (Transform




And in the Events tab you can trigger things like Playing a sound or particle effect once you PressTheActionlnput,
StarAnimation, EndAnimation, FinishTimerlnput, etc...

The GenericAction is a very powerful tool for the template, and there are several generic actions included in the
project, open the Basic Locomotion demo scene to see those examples in action.

When adding a new Animation to your Action StateMachine, make sure to use the vAnimatorTag “ CustomAction”
to it, so that the Controller knows you're doing an Action.

¥ = [« (v Animator Tag) @ 3 %

Useful Tags:
CustomAction - lock position and rotation to use
RootlMotion instead
LockMowvement - Llock character movement

@ LockRotation - Lock character rotation
IgnoreHeadtrack - Jgnore Headtrack and follows the
animation
IgnorelK - Ignore K while this animation is playing

Attack - Use to idantify Melea Attacks
ADD TAG
CustomAction

’ &dd Behaviour ]




| ANIMATOR TAG

This is an Animator Behavior that you can attach directly on Animation State inside the AnimatorController, it’s
useful to know what animation is being played and what you can do while this animation is playing.

We have a few useful built in tags such as the image below in the infobox, but you can also create your own tag
and verify in code, for example:

First access the vThirdPersonController via script so you can call the method

if(tpController.IsAnimatorTag(“MyCustomTag”)

{
//do stuff

¥ |G|+ v Animator Tag (Script) &,

Useful Tags:

CustomActon - lock position and rotation to use RootlMotion instead
LockMowement - Lock character movemeant

@ LockRotation - lock character rotation
IgnoreHeadtrack - Jgnore Headtrack and follows the animation
IgnorelK - Ignore IK while this animation is playing

Attack - Use to identify Melee Attacks
ADD TAG

Customaction

We also have a AnimatorTagAdvanced in case you want to check a tag but only during a certain period of the
animation, every animation goes from 0 to 1 and you can filter the tag to only run your method during this time.

‘!’ ¥ v Animator Tag Advanced (Script) g #

Useful Tags:

CustomAction - lock's position and rotation to use RootMotion
instead

LockMowement - Use to lock the character movement
LockRotation - Usa fo fock the character rotation
IgnoreHeadtrack - 7gnore the Headtrack and follows the animation
IgnorelK - Ignore K while this animation is playing

Attack - Use for Melee Attacks

ADD TAG
||
LockRaotation

All By Marmalized Time




| ANIMATOR EVENT MESSAGE/RECEIVER

Send a message from a AnimationState to any GameObject:
https://www.youtube.com/watch?v=uZn53kKsIOl

| MESSAGE SENDER/RECEIVER

With this component you can create Custom Messages and call several public methods using Events and trigger
them at any time by using a trigger for example.

In this example we have 2 Message Listeners:

- ForceHideWeapons will lock the input of drawing weapons and call the methods to lock the Shooter and Melee
input, it's useful for example when entering a npc area were you cannot attack anyone.

- UnlockWeapons were we call the method to unlock the hide weapons input and unlock the shooter and melee
input.

V' MESSAGE RECEIVER

o

i~ vMessageReceiver
E—

UnlockWeapons

On Receive Message (String)

Runtime Qnly 4 || vDrawHideShooterWeapons, LockDrawHideInput 4

- wShooterMeles| @

[ Runtime Snly :] [ wShooterMeleelnput.SetlLockShaoterInput
- vShooterMelee| @ [ ]

[ Runtime Snly =] [ wvShooterMeleeInput.SetLockMeleeInput

- wShooterMelee @] [

ForceHideWeapons

On Receive Message (String)

Runtime Snly # || vDrawHideShooterWeapons.FarceHideWeapans

i vShooterMelee @] [ |

[ Runtime Snly =] [ wvDrawHideShooterWeapons,LockDrawHideInput
= wvShooterMelee| @] W
| Runtime @nly 4| [ wShooterMeleelnput.SetlockMelzelnput

= vShooterMelee] @| W

[ Runtime Snly =] [ vShooterMelealnput.SetLockShaoterInput

- vShooterMelee| ©f (o

OPEN EVENTS

This is just one example, you can create any listener and call any public method you need.


https://www.youtube.com/watch?v=uZn53kKsI0I

Now to trigger those combined events of the MessageReceiver, we will use the vMessageSender to send the
message and the vSimpleTrigger to detect collision with the Player.

We created 2 empty gameObject called OnEnter and OnExit, add the vMessageSender and create the Message
ForceHideWeapons and UnlockWeapons, we also checked the option SendByTrigger since we're going to use the
vSimpleTrigger to detect the player.

v MESSAGE SENDER

ForceHideWeapons

MNone (W Message Receiver)

vV SIMPLETRIGGER

- wSimpleTrigger

Player 4

CLOSE EVENTS

On Trigger Enter (Collider)

Runtime Only % || vMessageSender.OnTrigger

- OnEnter (vMes| ©)
.+ - |

On Trigger Exit (Collider)

Runtime Only % || vMessageSender.OnTrigger

|- OnExit (vMesse )
S e

Now in the vSimpleTrigger we can use the option Use Filter to only detect the Tag and Layer "Player”, create a
box collider or mesh collider with the option IsTrigger checked and the layer "Triggers" that matches the size you
want and call the method "vMessageSender.OnTrigger" for each Event OnTriggerEnter and OnTriggerExit.



| BODY SNAPPING ATTACHMENTS

We created this feature to make it easier to transfer attachments from one controller to another.

This means that you can create a Prefab of a Character Attachments and quickly add to another character,
without the need of adding attachments one by one on each bone.

First, create an Empty GameObject inside your character, add the “vBodySnappingControl” and hit the “Create
New BodyStruct.

] Inspector

i —
Cipen

-
B
|
Heck |
Head B
Upper Chest -
Right Upper Leg - |
Right Lower Leg -
Right Foot .
Right Shoulder -
Right Upper Arm -
Right Lower Arm -
Right Hand .
Left Upper Leg -
Left Lower Leg -
Left Foot -
Left Shoulder .
Left Upper Arm -
|
LeftHand - |

LeftHand

Hips

Chest

Left Lower Arm




If your Avatar is already set up as Humanoid and all the bones are correctly mapped, it will all be automatically
assigned for you, in some cases Unity doesn’t recognize a Spine or Chest, so you need to fix by going to your

Avatar and assigning the correct Bone, example:

Mapping Muscles B Settings

Body

Optional Bone a
¥ Body
@ Hips |J..Hips (Transfarm)
(®) spine | L Spine (Transform)
¢t Chest [ L None (Transform)
:i: Upper Chest |..L5pim32 (Transform)

o o 0 6

Chest must be assigned before assigning UpperChest,




Now going back to our Character BodySnap Control, you can add all your character attachments such as particles
that activated on a specific bone, itemManager Handles, anything that you may use and assigned to a specific
bone, once you hit Play that GameObject will be attached to the bone you assigned.

0 “
With this feature you can set all the attachments your character in one

prefab, making it easier to transfer attachments from one character to
another.

Once you hit Play the attachments will go to the desired bones.

T V Body Snapping Control (Script) i,
v BODY SNAPPING CONTROL
- vBodySnappingContral
| o
a

Forward

On Snap ()
List is Empty

None (Transform)
None (Transform)
None (Transform)
None (Transform)

Head None (Transform)
RightHand A RightHand (Transform
RightUpperLeg
RightLowerLeg None (Transform)
RightFoot None (Transform)
RightShoulder None (Transform)
RightUpperarm None (Transform)
None (Transform)

AL LeftHand (Transform)

RightLowerarm
LeftHand
LeftUpperLeg None (Transform)
LeftLowerlLeg None (Transform)
LeftFoot None (Transform)
LeftShoulder None (Transform)

Leftlipperdrm None (Transform)

[ Hips  [INone (Transform) 1§ -
[ spine [INone (Transform) 1§ |-
[ chest  [INone (Transform) 1§ -
[ tieck  PNone (Transform) —— J§ |-
[ Head  PiNone (Transform) —— J§ |-
[ Rightdand | RightHand (Transform 1§ |-
[ RightUpperLeg I * RightUpLeg (Transforr[§ |-
[ Rightlowerleg [ None (Transform) ——— J§ -
[ RightFoor ____[INone (Transform) 1§ |-
[ Righeshouider I None (Transform) ——— J§ |-
[ RightUpperarm [ None (Transform) 1§ |-
[ Righttoverarm _ [None (Transform) ——— J§ -
[ LetHand | ‘LeftHand (Transform) 1§ |-
[ LefiUpperieg  WNone (Transform) ——— J§ -
[ Leftloverleg  [None (Transform) 1§ |-
[ tefocr  [None (Transform) ——— J§ |-
[ LeftShouldsr__JiNone (Transform) ———— F@ -
[ Lefpperarm  PNone (Transform) ——— J§ |-
[ LeflousrAm _ JINone (Transform) ——— FL-|

LeftLowerArm None (Transform)




| SNAP TO BODY

*Use this component with a vBodySnappingControl

Attach this component to any object to make it snap to a specific bone when you hit Start.

¥ =« WV Snap To Body (Script) o
Script |- wSnapToBody o

LeftShoulder ¥
AlignPosition AlignRotation

For example, instead of manually drag and drop objects like Armour, Helmet, Capes, etc... to each bone of your
character, you can create a Prefab called “Attachments” and add ‘SnapToBody’ on each object and assign where
this object must be attached.

This makes the workflow much easier when replacing the character model for example.




- MELEE FEATURES-



| MELEE MANAGER

V2.0 - You can add a Melee Manager Component by opening the Invector tab > Melee Combat > Component

Open Default Info: here you can setup the default values for Hand to Hand Combat

Open Events: here you can add generic events like trigger something when you make damage

Add Extra Body Member: If you need an extra hitbox for example a Head Hitbox for a zombie, you can add

Who you can Hit > Important this is the tag that will receive Damage, so if you are using this component on the
Player, assign the Tags of the gameObjects that you want to apply damage (the receiver need to have the method
TakeDamage).

Use Recoil > Check if you want the character to trigger a recoil animation when hit a wall

Recoil Range > max angle to allow trigger the recoil animation

Hit Recoil Layer > the layer that will affect the recoil (usually it’s the Default layer)

MELEE MANAGER

Clase
- wMeleeManager

Open Default Info
Add Extra Body Member

LeftLowerfrm RightLowerdrm
LeftLowerLeg RightLowerLeg

1

CompanionAl
»,

Mone (VW Melee Weapon) Mone (VW Melee Weapon)

When you assign the MeleeManager component into your character, it will automatically create default hitboxes
for both hands and legs, you can add an extra hitbox if you need.



The animations for the hand to hand combat can be set up in the Unarmed state machine, triggered by the
ATK_ID 0 and the defense DEF_ID 1 on the UpperBody Layer, Default Defense.

The Basic Attack State Machine is just an example, you can have as many State Machines you need, just
remember to set up the ID to the corresponding weapon.

You can use UpperBody to attack as well, this way you can move the character and attack at the same time.

You can set up as many combos as you want, just put the attack animation and apply a transition.

Every Attack State needs to have a vMeleeAttackBehaviour script attached.

StartDamage > Time of the animation that you will apply damage
End Damage > Time of the animation that will stop trying to apply damage



AHowM " | o chringtd amimati

*Removed on update 2.4.2 use the AnimatorTagAdvanced LockMovement and LockRotation instead

Recoil ID > Trigger a Recoil animation if you hit a wall or an object

Reaction ID > Trigger a Reaction animation when you take damage

Melee Attack Type > Select Unarmed or Melee Weapon

Reset Trigger > Check this bool for the last attack, to reset the combo

Attack Name > You can write an Attack Name to trigger different HitDamage Particles on the Target, Ex: If your
weapon has electric damage, you can match the Attack Name with the HitDamage Particle and instantiate a
different particle for this specific weapon.

Ignore Defense: it will apply damage even if the target is blocking

Active Ragdoll: activate the target ragdoll

\/ MELEE ATTACK CONTROL

BodyPart




| CREATING A MELEE WEAPON

To create a new weapon, you just need to select your weapon Mesh and go to the menu Invector > Melee Combat
> Create Melee Weapon.

= ———— A=
Y? I\.dehleel:omhat—DemoScene‘ = Tag [ Weap +] Layer [Ignore Rayca:t ]
Light
VHig\fe Prefab | Select | Revert [  Apply |
b MeleeCombatHive ¥ .~ Transform il
» Base_vRoom Position X 0 Y 0 Z0
P MeleeController Rotation X 0 Yo Zo
EventSystem Scale w1 ¥ 1 z[1
UL
" 0
GameController V ¥V Melee Weapon (Script) @
3rdPersonCamera
» Enemies T LT
» VirtualShield MELEe WEARON
SwordV_long
¥ Components
hitBox
SwordV_long
- hitBox (vHitBo
£ Project £
lcrmaerl G |4V
» G Editor 20
¥&3 Invector-3rdPersonController
> Basic Locomotion
¥&i Melee Combat —
» &3 3DMaodels —
>3 Animator
» & Audia
Pﬁ CemoScenes
Y& Prefabs | |
» &5 CharacterControllers
»E3 Environment
» G5 Items
=ttt

After that your mesh will be transferred inside the Components gameobject, and the parent will have a
vMeleeWeapon attached where you can set up your weapons settings.

A single hitbox will be created and if you need more you can just duplicate the first and assign into the Hitbox
List into the MeleeWeapon component.

IMPORTANT - don’t forget to set your Weapon Layer to Ignore Raycast and the Tag to Weapon, if you put a
weapon into an Enemy or Player and change the Layer and children’s, you need to set the weapon layer to
After creating your weapon, you can just drag and drop inside a hand Bone of your character and hit Play, the

MeleeManager will auto assign into the Weapon slot.

To change weapons ingame you will need an ItemManager assigned into your Character.

Attack Settings:



[Damage Options]

Value: Total damage of your weapon

Stamina Block Cost: How much stamina the target will lose when receive this attack while blocking
Stamina Recovery Delay: How much time will wait to start recover the stamina

Ignore Defense > Check if this weapon can pass through shield

Active Ragdoll > Check to make this weapon activate the Ragdoll of the target

Example of a weapon with 2 hitbox

HitBoxes List: Assign your hitboxes here

Damage Modifier: Extra Damage

Melee Type: Just Attack, Just Defense or Both;

(SOON) Use Two Hand > Check this if your weapon uses two hands (the left weapon will drop)
Distance to Attack > Used for Al only, to know the distance to attack if this weapon

ATK_ID > correspond to the Attack Animation State that will trigger

MoveSet_ID > it’s the correct move set that the character will move when using this weapon
Stamina Cost > how much stamina the attack will cost

Stamina Recovery Delay > how much time will take to the stamina start recovery

Defense Settings:

DEF ID > ID of your defense animation

Recoil_ID > Trigger a recoil animation

Defense Rate > how much damage you can defend from an attack

Defense Range > When you select the shield, a Gizmos will appear to help you see how much of Defense Range
you need.

Break Attack > Trigger a Recoil Animation on the Attacker



| HOW TO APPLY DAMAGE TO A TARGET

The target must have a vHealthController and a Capsule Collider so that our Damage System can identify it as a
living target and actually apply damage to it.

\/ VHEALTHCONTROLLER

Close Properties

- wHealthController

Health Events

Shooter: You need to set the Damagelayer of your target in the ShooterManager.

If you want to apply damage to individual body parts you can create a Ragdoll and set the collider layers to
BodyPart, each ragdoll collider comes with a DamageReceiver, you can even set a Damage Multiplier if you want
to apply extra damage in the Head for example.

OR if you’re creating a simple top down game for example, you can save performance leaving the enemies
without a ragdoll and applying damage directly to the main capsule collider, in this case you can set the Damage
Layer to Enemy.

SHOOTER MANAGER

Close Properties

« wShooterManager
Aim 1K

Armrmo Ul LockOn HipFire

Camera Sway Weapons

BodyPart
Player
Default




MeleeCombat: You need to set the Tag of your Target in the MeleeManager / HitDamageTags field, you can assign
several tags to hit different targets.

MELEE MANAGER

Open Default Info

Add Extra Body Member

LeftLowerArm RightLowerArm
LeftLawerLeg RightLowerLeg

sl

Mone (W Melee Weapo Mone (W Melee Weapo




ITEM MANAGER

- Add the ItemManager into your Player from the menu Invector > Inventory > ItemManager

Invector  Window Help

! Basic Locomotion »
Inventory » [ternManager (Player Only)
Shooter > [temEnums ¥
Melee Combat ¥ Create New ltemListData

Help il e e e e e

Resources

- Select the Inventory Prefab from the Project > ItemManager > Prefabs then drag and drop inside your Third
Person Controller, when you hit play it will be automatically assigned to the ItemManager.
- and a ItemListData > vShooterMelee_ltemListData

Inventory Syst B Project
|Cr!at!'| < |4|‘|

T r r ¥ &3 Invector-3rdPersonController
ITEMMANAGER CREATOR WINDDW S ivecors
|- Inventory_ShooterMelee 53 Basic Locomotion
> 3D Models
>l Icons
VIDEO TUTORIAL Y55 ItemListData

vMelee_ItemListData
vShooterMelee_ItemListData
¥&& Prefabs
» &5 Other
b Inventory_Melee
bl Inventory_Shooter
b Inventory_ShooterMelee
b G Scripts
b6 Textures
> i Melee Combat
> &l Shooter
>l vAI 2.0 Beta

- You can also add the IltemManager manually using the Add Component button via inspector, but don’t forget to
assign an ItemListData.



¥ = ¥V Item Manager (Script) G = #*

ITEM MANAGER

~ vItemManager

Place a Inventory Prefab inside your Character, it will be
@ auto-assigned when you enter Playmode,
¥ou can find the prefab at the Inventory/Prefabs folder

Mone (VW Inventory)

You can find the default ItemlListData at the Inventory/TtemListD ata
folder, or create a new list at the Invectar Menu

Ll vShooterMelee_ItemListData (vitemr
||

OPEN ITEM LIST

Start tems 0

Cpen Equip Paints
Open Attribute Events

In the tab Events you can call methods like lock the input of the character while the Inventory is Open, just
assign the Character (from the scene hierarchy) and call the method Lockinput from the vMeleeCombatinput or

vShooterMeleelnput.
Here are the most used events you can use to:

- Hide/Show the mouse cursor

- Lock/Unlock the cursor at the screen center

- SetLockAlllnput to lock all the input from the controller (basic, melee and shooter)

- ResetlnputAnimatorParameters to reset back to zero the animator parameters, useful when using the
CharacterCameraPreview inside the Inventory, this way if you’re walking and open the inventory, there
character will be at Idle in the camera preview.



Close Events

On Open Close Inventary (Boolean)

Runtime Only # || vShooterMeleeInput.ShowCursar

-~ vShooterMely ©|

| Runtime only ¢ || vShooterMeleeInput.LockCursor
[« vShooterMeld ©|

| Runtime Cnly $ || vShooterMeleeInput.SetlockAllInput
[« vShooterMely ©|

| Runtime ©nly $ || vThirdPersenController,ResetInputAnimatarP:$ |
[ vShooterMeld] @]

Click at the Add Item button to open the Filter, so you can search or filter exactly what ItemType you need:
You can add multiple ItemTypes to filter multiple items.

Add Item

ItemSelector

¥ Filters (1)
[ Melee Weapan

[

1D oG
- Axe
= MeleeWeapon

D o1
- Short Katana
- MeleeWaapon

D03
= Short Sword
- MeleeWeapon

s Niry
- Great Sword
- MeleeWeaapon

1o 08
- Great Katana
= MeleeWeapon

Once you add a Item in the list, you can use the option Add To EquipArea to automatically assign this item to a
specific EquipArea (it will only be assigned if your itemSlots are currently empty, if one is already assigned, it will
be equipped in the next one in the list)



The AutoEquip will auto equip this item to the EquipArea and also change the EquipmentDisplayWindow to where
the Item is equipped.

Change Attributes

Click in the Open Item List button, to manage, search or create new items

ItemnList Editor

v [TEMLIST
ADD ITEMS

CREATE NEW ITEM
OPEN ITEMENUMS EDITOR

You can create new items or duplicate a current one, keep in mind that each item has a unique ID.

When creating a Weapon Item, you need to assign the Original Object (that instantiate into the Player with a
vMeleeWeapon or vShooterWeapon) and a DropObject which we have a prefab called “CollectableEquipment”
that you can use and it will automatically drop the item you assign or create a unique collectable with a mesh
that matches your item.



Tactical Shotgun
Shooter 3
||

. shotgunlcon

O vShotgun IdvCollectableShotg

Attributes

X

Custom Settings

defaultPaoint
0.5

Don’t forget to add the attribute Damage & AmmoCount of your weapon, this will allow you to drop and collect
your weapon with the same amount of weapon, making it into a unique weapon.

This Inventory Example goes further and further into options to customize, like consumable items, if is stackable
or not, and much more that is better explained on video tutorials that you can watch on our


https://www.youtube.com/channel/UCSEoY03WFn7D0m1uMi6DxZQ

| INVENTORY

We have basically 3 Inventory Examples in the project, you can find them in the folder ItemManager/Prefabs.
Just drag and drop inside your character to test it, make sure to also use the corresponding ItemListData at your
ItemManager according to what Inventory you’re using.

For ex: ShooterOnly requires the vShooterMelee_ItemListData, MeleeOnly requires the vMelee_ItemListData

- EQUIPMENT ITEMS OPTIONS =

WEAPONS >

vToolbarSelector

GREAT KATANA

Defense Range : 70

b | [
Select: ) Unequip: = Back: Ese

- ToolbarSelector: It’s basically a menu, you can set the input to switch tabs at your Inventory

- Equipment Display Window: It shows the current slot of a EquipArea, you can have multiple slots and
multiple EquipAreas at the same time and rotate the slots via input

- EquipArea: A row of EquipSlots

- Equip Area Control: Responsible to inform the EquipmentDisplay

- EquipSlots: Display a specific Item, you can use the ItemType to filter what item can be displayed on this
slot

- ItemWindow: A window that display Items, you can filter what ItemType will be displayed using the filter
‘Supported Items’



This is an example of a window that displays several different Items based on their Types.

EQUIPMENT ITEMS OPTIONS

CONSUMABLES MELEE SHOOTER

USE

DROP

DESTROY

CANCEL

|||||||!!!| vitemSiot

1 GREAT KATANA % 1 VRIFLE SHOOTER EDITION

- ItemWindowDisplay: Manage what happens with the ItemWindow when using, drop, destroy and cancel
- ItemOptionWindow: Buttons that buttons Ul to use, equip, drop, destroy and cancel

You can see a MasterWindow component on each main window of the Inventory, you can use the MasterWindow
to manage your windows for example if you open a window and open another, you can press the back button to
close the current window and get back to the previous, it’s basically a window manager.



You can also use the Events OnEnable/OnDisable to for example, turn on / off specific objects, call animations,

sounds, etc...

v MASTER WINDOW

-« yMasterWindow

I EquipmentInventary

CLOSE EVENTS

On Enable ()

Rurnitime Only $|| GameObject.SetActive

ﬁEquipmentInw |

[Runtim: Cnly =] [UFid!CiHUiE..ﬁ.lFl‘liFu”

| - EquipmentDisp @

| Runtime Cnly ¢ | | Animator.Play
|% CharacterPrev. ©| CharacterPreviewsSlide_Reverse

on Disable ()
Runtime Cnly $ || vEwventWithDelay.DoEvent

- EquipmentDisp ©fo0




| CHECK IF ITEM IS EQUIPPED

You can use the component vCheckltemisEquipped to check if a specific Item or IltemType is currently equipped.

V/ CHECK IF ITEM S EQUIPPED

« wCheckItemIsEquipped
Mone (V Itemn Manager)

DoSamething

R
s

I
On Is Itemn Equipped ()

List is Empty

On Is Item Unequipped ()

List is Empty

You can attach this component directly to the character or inside the character (check the option “GetIinParent”
if it’s inside the Player).

Name - just the name of your event, so it’s easier to identify what it does
ItemsID - You can add one or more items to trigger something specific, for example, when equipped with Potions,
you can enable the Ul Button to use those items, when unequipped simply disable the object.

You could either filter the ItemID’s of your Potions or set the ItemType Consumable in this example.

1

Consumable




| CHECK ITEM IN INVENTORY

With this component you can check if you currently have or not a specific item(s) in your Inventory and use
Events to do something if true or false.

\/ CHECK ITEM IN INVENTORY

1

On Caontain Item ()

Runtime Only # || vHUDCantroller.ShowText %

.~ HUD (vHUDC @| You have Pation!

On Mot Contain Item ()
Runtime Only # || vHUDController.ShowText %

.~ HUD (vHUDC @| You don't have Potion!

*Element O = Item ID



| COLLECTABLE STANDALONE (NO INVENTORY)

If you don’t want to use the IltemManager to manage your items, we have another solution for ‘on demand’
collectibles, notice that you can only equip 1 item, once you try to equip another the current item will drop.

Take a look into the Demo Scene called “vShooterMelee_NOInventory”, instead of adding the ItemManager
component, now you will add the “vCollectShooterMeleeControl” component to automatically collect and equip
weapons.

You need to create the defaultEquipPoint to equip weapons and assign inputs to drop them.

v COLLECTMELEECONTROL

Close Properties

- vCollectShooterMeleeControl

Right Handler

L defaultEquipPoint (Transfarm)

Left Handler

A defaultEquipPoint (Transform)

Unequip Right Input

Right&rrow Acis
D-Pad Horizantal A

D-Pad Haorizantal Axis

Unequip Left Input
D-Pad Harizantal =

A
D-Pad Harizantal Axis

- wShooterDisplayWeapon_Standalor

S
il

We also have a pretty simple example of a Display HUD to show what weapons you’re equipped with, it’s called
“vShooterDisplayWeapon”, search in the project folder and drag and drop the prefab into the scene.

For the ItemManager we need a prefab for the actual weapon that goes into the Player and another to be the
Collectable, but in this case the CollectableStandalone is both. Take a look into one of the several examples of
collectables we have for both melee and shooter weapons.



V/ VCDLLECTABLESTANDALONE

- wCollectableStandalone

ane (Transfarm)

defaultEquipPoint
vwShotgun_Nolnventory

“Ishotgunlcen

OPEN EVENTS

It's important to assign the correct gameobjects into the Events, we turn off the collision and gravity of the
weapons when equipped and turn on when you drop them.



| CREATING A ENEMY Al

Invector > Melee Combat > Create NPC and change the Character Type to Enemy Al

After hitting the Create button, our scripts will handle all the most time consuming stuff and make the Al almost

done to hit Play, you just fieed to/BAKE a NaVMESHon the Scene!

Locomotion - It works pretty much the same as the Character Controller, you still need to set up the

Layers - just like the Player, you need to set up a Layer for the Al (Enemy) and a layer for the Ground (Default).
If you equip a Weapon on the character, don’t forget to assign the Layer Triggers for this weapon.

Combat - Here you will have a lot of options to make very different combat behavior, you can add a chance to
block (if equipped with a defense weapon), chance to roll, chance to defend an attack, change the attack
frequency, strafe around the target, etc...

Waypoints - You can add waypoints for the Al to follow in sequence of activate the option to Random.

We manage to get better results with the NavMesh using this set up, but of course this will depend on your scene,
terrain, meshs, etc...

Baked Agent Size

0.35
Agent Radius |0.3
Agent Height (1 |
Max Slope - |46
Step Height |0.35

Generated Off Mesh Links

Drop Height [4.1 |
Jump Distance [3 |
¥ Advanced
Manual Voxel Size ]
Voxel Size 0.1

300 vouels peragentradius

Min Region Area |0.5

Height Mesh ]


http://docs.unity3d.com/Manual/nav-BuildingNavMesh.html

Field of View > total range to detect the Player

Strafe Distance > once in combat, the character will move Strafing
Attack Area > total range to attack

Min Detect Distance > Min distance to detect the player, even if the player is outside the Field of View range.



| LOCK-ON TARGET

You can add a Lock-on component into the Camera by opening the 3™ Person Controller menu > Components >
Lock-On. The component will be ready to use, you can set up the input that activates the Lock-on in the
ThirdPersonController script, at the method LockOniInput.

LOCK-ON 8Y INVECTOR

.+ LeckOnTargetControl

Default

~ LockOnTarget (Rect Tran
_UI(Canvas)

You can also display a Sprite Image into the Target by assigning an Image and Canvas.

Hide Sprite will hide the sprite if the target if lock-on is false. Set off-set Y by changing the value of the Sprite
Height.

You can use the LockOn with any target as long as you add a vHealthController to this target, so that the LockOn
can identify whether this target is alive or dead.



| WAYPOINT SYSTEM

You can create a Waypoint Area by opening the 3™ Person Controller > Component > New Waypoint Area. To
create a new Waypoint, just hold Shift + Left Click on any surface with a collider, to reposition the same
waypoint hold Shift + Right Click. The same goes to create Patrol Points, but you will hold Ctrl instead of Shift.
You can assign this Waypoint Area to many Al as you want, and limit the area / limit of Al that will access.

Patrol Points are points of interest that one waypoint has, for example if you have a corridor with 3 rooms, you
can create 1 waypoint in the middle of the corridor and 3 patrol points with Max Visitors of 1, this means that if
an Al is already on a room, the other Al will not come to the same room, he will go to the next one.

Time to Stay is how much time the Al will stand there.
isValid is a bool that you can turn on/off to disable a waypoints/patrol point in real time.

You can make the Al walk randomly at waypoints by selecting the option Random Waypoints on the Al Inspector.
To make random patrol points, select the option Random Patrol Point on the Waypoint Inspector.

Waypoints are represented by Spheres and Patrol Points are represented by Cubes.

WAYPOINT ARZA BY INVECTOR

Winypoent 02

Waypaint 03




CREATING A COMPANION Al

Same process as creating a Player or EnemyAl, just select CompanionAl on the Character Type.

The Companion has the same variables as the EnemyAl, plus:

Player
10

None (Transform)

If you open the v_AlCompanion script, you will see that we have a method call Companioninputs and you can
customize for your needs, this method contains the basic commands like Follow, Stay, Aggressive/Passive and
MoveTo (you can send the Al to a specific spot by an Vector3)

Default Inputs:

- Stay

- Follow

- Aggressive/Passive

- Move to (moveToTarget)

*Notice that the transform target height can be no higher than 0.5f from the navmesh, otherwise he can’t find a
path to go.



| WEAPON HOLDER MANAGER

*This feature requires a ItemManager

Add this component to your Shooter Controller and there is no need to setup anything here:

v WEAPON HOLDER MANAGER

(1]

~ wWeaponHolderManager

- vWeaponHolderManager
4
= RifleHolder (vWeaponHolder)

1+ ShotgunHolder (vWeaponHolder)

~ BowHaolder (vWeaponHolder)

i~ HandgunHolder {vWeaponHolder
||

Now go inside your controller, create an empty gameObject and add the vWeaponHolder component.

In order to use the WeaponHolder, you need a WeaponHolderManager
in your Controller and a temManager to check the temID

1" V Weapon Holder (Script) i,

v/ WEAPON HOLDER

- vWeaponHolder
Right&rm

I rifle_renderer




The EquipPointName can be found in the ItemManager > EquipPoints.
By default it comes with 2 EquipPoins, LeftArm and RightArm but you also create your own custom equipPoints.

Close Equip Points

A defaultHandler (Transform)

Custom Handles

On Instantiate Equiment (GameOhbject)

Runtime Only 4 || vMeleeManager.SetLeftWeapan

- vShooterM o

| Runtime Only  # | | wShooterManager.SetLeftWeapon
- vShooterM o

A defaultHandler (Transform)

Custom Handles

On Instantiate Equiment (GameOhbject)

Runtime Only # || vShooterManager.SetRightWeapaon
= vShooterM| o

[ Runtime Only :] [vM!I!!Manaqur.ﬁ!tﬂ!ightwlapnn
- vShooterM @

The ItemlID can be found in the ItemManager ItemListData, there you can also set what animation will be played
when you equip/unequip your weapon.

The HolderObject is in case your weapon has a holster or something.
And the WeaponObject is just the 3D model without any scripts or collision, you can add all of this inside the
character and leave it disabled. (Check our demo scenes to see examples)



| DRAW/HIDE WEAPONS

This feature is to automatically or via input hide weapons without unequipping them.

v/ DRAW/HIDE SHOOTER MELEE WEAPDNS

(1]

||

USE Hide And Draw Weapons Input

It’s pretty straightforward to use, simply add the component to your ShooterController, it must already have a
IltemManager and a WeaponHolderManager already setup.

By checking the option Hide Weapons Automatically a field will appear so you can set a timer, for example after 5
seconds with the weapon equipped if it will hide or you can leave it unchecked and use an Input to draw/hide the
weapon.

You can also call the methods HideWeapons and DrawWeapons on events, for example, in the if you want to hide
your weapons when performing a GenericAction, go to the GenericAction component and call the method to

HideWeapons in the OnStartAction Event.



